Word processing on a computer is simple. You start

to type your text, typically using a keyboard. At the
end of the first line the cursor will automatically move
down to the next line. This feature is called word-wrap,
and it means you cannot make a line that is too long.
If you make a spelling error as you type, you do not
have to correct it immediately. Some word processors
will underline typing or grammatical errors for your
attention, but you can position the cursor with a
mouse or cursor keys to delete or add letters, words,
phrases, sentences or paragraphs — however much text
you want to change. Also, you do not need to type

the entire document at once, because you can save
your work and return to it later — either to continue
or to make changes. Documents can also be emailed
or downloaded from online storage (Fig 5.1). Making
your words look good is straightforward, too. Unlike

a typewriter, you can have different styles and sizes of
the typeface in your document.

Example of a Flowchart

Example of a Flowchart

Hello Miss

This is my example of the flowchart

Thanks Miss
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flowcharts.docx (41K) >
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Fig 5.1 Word-processed documents can be emailed

WORD PROCESSING

Introduction to word processing

Before you improve the look of your document, you
should know how to start with a blank document, open
one already created and save your file with a new name.

When you first launch a word-processing application,
you can begin to type using a blank document. You can
also open an existing file to a new document window
or switch from a current document to a new screen
without having to close any documents.

Key features
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Fig 5.2 shows some of the features when working with a document

1 Title bar: This indicates which application you
are presently using and shows the name of the
document at the top of the screen. When you create
a new document, the name of that document will be
‘Document 1’, for example.

2 Ribbon: This is shown in recent versions of
Microsoft Word. It replaces the Menu bar found on
earlier versions It contains the menu of commands
used to format your document. It has multiple

tabs with groups of similar commands. Most of the
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Standard toolbar and Menu bar items from earlier
versions now appear on the Home tab.

3 Quick Access Toolbar: This toolbar shows commonly
used commands such as Save, Undo and Redo.

4 Input screen: The input screen is the part of your
screen where you type your document text.

5 Status bar: The status bar displays information such
as the document’s page and word count.

6 Scroll bars: Scroll bars are used to scroll the page on
the screen, such as upwards, downwards or from left
to right.

7 Ruler: The ruler displays the measurements, indents
and tabs of your document.

As you prepare a document, it is important to understand
the layout of the page. This includes the margins, paper

size, paper source and orientation of the page.

Margins

It is usual to see a small gap between the text on a page
and the edge of the page. This gap is called a margin.
Margins are typically 1 inch from the edge. Leaving a
margin is especially important when you need to bind
a document together. It is also useful when you want
to add a page number or a heading that prints on each
page. More importantly, most printers cannot print
right to the edge of the page. You can normally select
the size of the top, bottom, left and right margins or
type each one separately by typing in the distance from
the edge of the page to the text.

Paper size

You can select different sizes of paper on which to
prepare your document. The size of paper affects

the page length and width of the workspace.
Typical sizes are letter size (815" X 11"),

A4 (210 X 297 mm) and legal size (8%" X 14").

Orientation

Documents are in one of two orientations, which are
usually known as portrait and landscape (Fig 5.4).

Last Custom Setting
Top: 0.5" Bottom:0.5"
Leftt 05" Right: 05"
Normal
Top: B Bottom: 1"
Left: [ Right 1"
Narrow
Top: 0.5" Bottom:0.5"
Left: 0.5" Right: 0.5"
Moderate
Top: ¥ Bottom: 1"
Left 075" Right: 0.75"
Wide
Top: ] i Bottom: 1"
— Left 2" Right 2"
Mirrored
[ | 1 Top: 1" Bottom: 1"
3 Inside: 1.25" Outside: 1"
- Office 2003 Default
| Top: 1" Bottom: 1"
— Leftt 1.25" Right 1.25"
Custom Margins...

Fig 5.3 Margins can be customised for each document

Sometimes portrait is known as tall and landscape is
known as wide.

Portrait

‘ ]

Fig 5.4 Portrait and |
landscape orientation '

Editing text

Once you have entered your text you can easily edit

Landscape

it. This means that you can correct mistakes before
presentation of the final document. Most of the

time you may have to select more than one word, or
sentence, paragraph or page. You can select a block of
text by using the mouse or the cursor keys. When a



block of text has been highlighted, it can be edited: the
font, style, size and alignment of the block of text can
be changed.

There are three main ways of editing text:

+ adding, deleting and retyping text
¢ moving, copying and pasting text
+ searching for and replacing text.

Adding, deleting and retyping text

To add or delete text, place the cursor at the desired
location and click the left mouse button once. To
insert text, start typing! The existing text will move
to the right to accommodate the new text. To delete
text, press the Delete or Backspace key. The Delete key
will delete all text to the right of the cursor while the
Backspace key will delete text to the left of the cursor.
You can create blank lines by pressing the Enter key.

Moving and copying text

It is also possible to delete part of your text such as
words, sentences or paragraphs, and replace that part
with new text.

First select the text you wish to delete, and then start
typing. The selected text will disappear and be replaced
by whatever new text you type. An alternative is type-
over mode, which causes any text to the right of the
cursor to be replaced or ‘typed over’ as you type. The
Insert key on the keyboard toggles between insert and
type-over mode. OVR appears in the status bar at the
bottom left side of the application when the type-over
mode is active.

A third way to select text is to place the cursor

at the beginning of the required text. Select the text
by pressing and holding down the left mouse button
and dragging the mouse across the text to be
selected, releasing the mouse button at the end of the
selection.

A quicker way to select a word or a block of text is to
perform block operations.

5.1 Introduction to word processing

Performing block operations

+ To select a word, double-click on it.

¢ To select a sentence or paragraph, triple-click on a
word in it.

+ To select a block of text, click at the beginning, hold
the Shift key and click at the end.

¢ To select the entire document, hold down the C#r/
key and press 4 (for All).

The basic copy, cut and paste operations work the
same way in most Windows applications. Text that is
copied or cut is placed in a temporary storage place

called the clipboard.

To move text, you must ‘cut’or remove the text from
where it is and ‘paste’it in its new location. To do this,
select the text and then click the Cut icon on the Standard
toolbar, Edit menu or Home tab of the ribbon (you may
also use Ctr/ + X on the keyboard). The text disappears and
moves to the clipboard. Click the mouse pointer or use

your cursor keys to where you want to move the text and
then click the Paste icon or press C#r/+ V. 'The text moves
to the new location.

Dathny Dathny

Dorothea Enid
J rothea
Enid Dathny Do
Enid
Using cut... and paste

Fig 5.5 Using cut and paste

A similar process is used for copying. First select the text
and then click the Copy icon (or use Ctr/ + C). The text
stays where it is but the word processor keeps a copy in
the clipboard. Move the cursor to where the text will be
inserted, and paste it. The text appears in both places.

Sometimes as you are typing, it is easier to use
keyboard commands to move to another part of the
document. Table 5.1 shows some of the commands you
can use to move the cursor.
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Fig 5.6 Using copy and paste

Table 5.1 Keyboard commands used to move the cursor

<Ctrl><left arrow> Move to previous word

<Ctrl><right arrow> Move to next word
<Ctrl><up arrow> Move to previous paragraph

<Ctrl><down arrow>  Move to next paragraph

<Home> Move to beginning of line

<End> Move to end of line

<PgUp> Move to previous screen

<PgDn> Move to next screen

<Ctrl><PgUp> Move to top left of screen
<Ctrl><PgDn> Move to bottom right of screen
<Alt><Ctrl><PgUp> Move to beginning of text on screen
<Alt><Ctrl><PgDn> Move to end of text on screen
<Ctrl><Home> Move to beginning of document

The Undo and Redo commands

If you make a drastic change in your document that you
did not intend (like accidentally deleting a whole page),
don't panic! As in most Windows applications, you have
a chance to retrieve your last action by clicking the Undo

icon or using the C#r/ + Z keyboard combination.
Certain changes may not be reversible, but your word
processor will often warn you of this beforehand. If you
clicked the Undo icon, and you wish that you had not
undone your last action, you can click on the Redo m
icon. Many word processors allow you to do multiple

Undos and Redos.

Save vs. save as

Under File on the Menu bar are options of Save and
Save As. If you are working in a new document and you

select Save, your word processor asks you for a filename.
If you are working in a previously saved document and
select Save, the word processor, without warning you,
saves the newer version to replace the older version of
the document. The older version is lost. If you select
Save As from the File menu, then you can give the
document a new filename or save it in a new location.
You will then have both old and new versions saved.

Fonts

A font is a style of writing. Modern word processors are
supplied with a wide range of fonts for you to choose
from. Different fonts are useful for different purposes.
For example, plain fonts such as Arial and Times New
Roman are good for writing letters and reports.

This font is called impact
This font is called Berlin Sans

This font is called comic sans
This font is called Arial

This font is called Times new roman

Fig 5.7 Different fonts are useful for different purposes

Fontsize

Most fonts are scalable, which means that they can

be as big or as small as required. The size of a font is
specified by a number known as the font size. Sizes 10
and 12 are the most common for writing letters and
reports. Font sizes are specified in 1/72ths of an inch.
So fonts at size 72 are one inch tall and fonts at size 36
are half an inch tall.

Size 12

Size 36

Size 72

Fig 5.8 Font sizes



Font style
Each font can have a range of extra styles applied to it.
The six common styles are:

¢ Normal: no special style is applied to the font.

¢ Italic: the font will be displayed as if it is leaning
slightly to the right.

+ Bold: the lines used to draw the font will be drawn
extra thick to make the text stand out.

¢ Underline: a line will be drawn underneath the text.

+ Superscript: the text is raised up to the top of the
line and printed at a smaller size.

+ Subscript: the text is lowered to just below the line
and printed at a smaller size.

Normal Style
Underline Style

Italic Style

superscript style

Bold Style

subscript style

Fig 5.9 Examples of font styles

Alignment

Alignment describes the position at which text
appears on a line on the page. Alignment is sometimes
known as justification. There are four different types
of alignment: left, right, centre and fully justified, as
shown in Figure 5.10.

This is an example of text that is left aligned
on the page.

This is an example of text that is right
aligned on the page.

This is an example of text that is centred on
the page between the left and right
margins.

This is an example of text that is fully justified
on the page between the left and right
margins.

Fig. 5.10 Alignment of text

Working with tabs

Tabs enable you to align your text to the left, right,
centre or full justification, or align to a decimal point.
You can also automatically insert specific characters,
such as periods or dashes, before the tabs.

5.1 Introduction to word processing

The ruler shows where tabs are located on your
document. Click View, Ruler to show the ruler at the
top of the page and to see any tabs (Fig 5.11). In later
versions of Microsoft Word, click on the ruler to insert
tab stops. In earlier versions (like 2007) you can select
the Page Layout tab from the menu to reveal the tab
stops dialogue box.

A tab position is the distance of the tab location from
the left margin on the line. You can choose the desired
alignment by clicking the leftmost edge of the ruler as
shown by the arrow in Figure 5.11.The different tabs
are shown as you click. Then set the tab by clicking on
a location on the ruler. You can place more than one
tab on the ruler or drag the tab to move it to another
location on the ruler.

L7
& L 1 L &
I Left Cantre Decimal Right
Left aligned
Canre
10:50

Right afigned

Fig 5.11 Four types of tabs

Format Painter

Sometimes you may have formatted one part of the
document and would like the same formatting on
another part. You may have noticed the ‘paintbrush’
button on the Standard toolbar ¥ Format Painter .

This button is called Format Painter, and it is a very
useful button. Format Painter copies character or
paragraph formatting from one place to another within

a document.
To copy paragraph formatting:

1 Select the text.

2 Click the paintbrush button and then paint
(drag across) the text that you want to apply the
formatting to.
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If you double-click the Format Painter button it
becomes a toggle so that you can paint the new
formatting to several paragraphs.

3 Double-click within the paragraph where you want
to copy the formatting.

4 Click the Format Painter button.

5 Select the paragraph or text that should be
reformatted to look like the first paragraph.

6 If you have activated the Format Painter in this
way, press Esc when you're finished and your mouse
will return to normal.

Paragraph formatting

With today’s word processors, it is possible to control
precisely the amount of space between paragraphs.
There is no longer any need for the old typewriter style
of pressing the Enter key twice to separate paragraphs.

Line spacing

The space between the lines, also called line spacing,

can be changed in the whole document or in a specific
block of text. You can also determine the line spacing
before typing your text. If you do, the line spacing you
choose will be applied to all text you type until you select
another line spacing value. Also, once text has been
typed, you can select a text block or part of the document
and select the line spacing you wish. Table 5.2 shows
some typical line spacing and their keyboard shortcuts.

Table 5.2 Types of line spacing

Single Inserts a line spacing alittle  Ctrl + 1 formats text
larger than the size of a as single spacing
character

1.5Lines |Insertsa line spacing Ctrl + 5 formats text
equivalent to one-and- as one-and-a-half
a-half times the size of a spacing
character

Double Determines alinespacing  Ctrl + 2 formats text
twice the size of a character asdouble spacing

Indenting

An indented word or paragraph is set at a distance
away from the margin (left or right). A word may be

indented from the left margin simply by placing the
cursor to the left of the word and pressing the 7aé key.

To indent a paragraph, select the paragraph to
be indented. Click the indent icon <= 3=: Left

for indentation from the left margin or Right for
indentation from the right margin.

Page numbering

Pages in your document should be numbered to keep
them in order. Note that page numbering may also be
added in the header or footer section of the document.

You can number the pages like this:

1 Click Insert.
2 Click Page Number.
Select the Position (top or bottom) and the

[~

alignment on the page (left, right, centre).
4 Click the Format button.
Use the dialogue box (Fig 5.12) to adjust how your
page numbers appear, the number from which they

wun

start if page numbering does not start from the first
page.

6 Click OK to return to the page.
Page Number Format ? X
MNumber format: |1, 2 3, .. ~

[ include chapter number

Chapter starts with style: | Heading 1 it

Use separator:

~ (hyphen) R

Examples: 1-1 1-A

Page numbering

O Continue from previous section

-

@ Startat: 1 =

Fig 5.12 The Page Number Format dialogue box

Cancel

Find and Replace

The Find and Replace function (often called
Search and Replace) will first look (search) through



the document to find one or more words that you
specify. Once the word is found, the computer can
automatically replace it with another word that

you type in. This is usually the Replace All option.
Alternatively, you can use another option simply called
Replace. This asks you to approve each replacement.
This is safer because you may not want to make the
change everywhere.

If you start your search somewhere in your document,
a dialogue box will pop up confirming whether you wish
to continue the search from the start of the document.

Find and Replace 7 »

Fingd Replace GoTo
Find what: Gaminig

Raplace with:

More »» Beplace Replace 4l

| Endhes | Cancel

Fig 5.13 The Find and Replace dialogue box

5.1 Introduction to word processing

1 Explain the difference between:

a Openand New
b Save and Save As.

2 What do you understand by ‘selecting' text?
3 You have two paragraphs of text typed, which you

want to edit. How many paragraphs would you have
if you:

a copied and pasted paragraph 2
cut paragraph 1

clicked Undo

clicked Redo

clicked Copy.

L - P T -

4 State the keyboard combinations used to create

single, double and one-and-a-half line spacing.

5 Describe the benefits of using the Format Painter.
6 FExplain one advantage and one disadvantage of

using the Replace All option.

Exercise 1: Selecting text

1 Open a blank Word document.

2 Type the following text: It was 5am on Saturday
morning. She was at the airport waiting to come
home.

w

Double-click on the word ‘morning’.

4 Triple-click on the text. Click on the Copy icon,
and paste the text three times.

5 Click at the beginning of the first sentence, hold
the Shift key and click at the end of the first
paragraph to select a block of text.

6 Hold down the Ctr/ key and press 4 (for All) to

select all the text in the document.

Exercise 2: Block operations

1 Type the following:
Workshop (press Enter)
Travel (press Enter)

Practical exercises using Microsoft Word \

2

Script (press Enter)

Education (press Enter)

Use the block operations or cut, copy and paste
options to move the text into alphabetical order
— Education, Script, Travel, Workshop.

Exercise 3: Find and Replace

1

Type the following text:

When you click Online Video, you can paste in
the embed code for the video you want to add.
You can also type a keyword to search online for
the video that best fits your document.

2 Use the Find and Replace function to change all

]

occurrences of the word ‘video’ to ‘recording’.
Format the text to double spacing.

Create an indent for the first line of the
paragraph.

Insert page numbering centred at the top of the
page.
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Headers and footers

Suppose you want to place a heading or logo at the top
of each page of your document, or maybe a page number
at the bottom of all the pages of the document. Text
which appears at the top of each page but inside the top
margin, is known as a header. Text which appears at the
bottom of each page is known as a footer.

In Microsoft Word, the header is shown within the
broken lines. Any text typed in this section, will
automatically appear in a similar position on all
subsequent pages. A footer is similar, except that it is
placed at the bottom of each page (Fig 5.14).

This is 3 header

This is a footer

Fig 5.14 A header and footer

The Header and Footer toolbar, or Design tab on the
ribbon when the header or footer areas are active,
provide the tools you need to format the top and
bottom margins in a document. You can use the

same header and footer throughout a document or
change it for part of the document. For example, you
can use a graphic in the first-page header, and then
include the document’s file name in the header for the
following pages. Many word processors will also let
you type special codes which will automatically insert
information such as the current date or current page
number into the header or footer of a document.

Footnotes and endnotes

Footnotes and endnotes have many uses, ranging
from supplying extra information about a topic within

Document organisation

the body of the text to providing a reference for a
quotation used in the text. A footnote or endnote is
made up of two parts: a reference number in the text
and the actual entry at the bottom of the page or at
the end of the chapter or text. Using auto-numbered
footnotes or endnotes allows you to delete, insert and
rearrange your footnotes or endnotes without having
to worry about the numbering. Footnotes are usually
placed after a separator line at the bottom of the page
that contains the footnote reference number. Endnotes
are placed together at the end of a section or the entire
document.

Section breaks

To understand how a section break works, think of
your document as a book with different chapters or
sections. A section break is a2 mark inserted to show the
end of a specific part of a document, and the end of the
formatting that is applied to that section. This mark
stores the section formatting such as page orientation,
margins, headers and footers or sequencing of page
numbers. The mark appears as a double dotted line
with the name of the kind of section break in the
centre. In a word processor such as Microsoft Word
there are four types of section breaks:

¢ Continuous: inserts a break and starts the next
section on the same page

¢ Next Page: inserts a section as well as a page break
and starts the next section on the next page

¢ dd: inserts a section break and starts the new
section on an odd page

¢ Even: inserts a section break and starts the new
section on an even page.

change-to-match-the:new-theme.-Save-time-in-Word-with-
them.q] Section Break (Next Page)

Fig 5.15 Section break in Microsoft Word

Section breaks therefore allow you to specify where the
different formatting will begin and end. You might use
section breaks in the following situations:



different headers and footers: if the document you
are working on needs to have different headers and
footers on various pages

different numbering schemes: if you are working
in a document where the table of contents needs
different numbering such as letters, numbers and
Roman numerals

different paper sizes: if you want a document to
contain portrait pages for text and landscape pages
for tables and charts

different margins: if the first page of a letter needs
a two-inch margin, and the following pages need a
different margin

columns: you can use your word processor’s
newspaper column feature in the middle of a
page, and place section breaks before and after the

5.2 Document organisation

multiple columns. If you have text prepared and put
it into a column format, your word processor will
automatically put in the section breaks.

~ctinm o

1 Whatis a section break?

2 ‘You have a document that contains sections breaks.
State whether odd section breaks or even section breaks
would have been applied to pages 17,22 and 35.

3 Give two situations where the use of sections would
be appropriate.

4 Describe an example of how a footnote is used in a
word-processing document.

5 What are the similarities and differences between
footers and footnotes?

Practical exercises using Microsoft Word A .

Exercise 4: Headers and footers

1 Navigate to the Header and Footer icons (View
or Insert in different versions of Microsoft
Word).

2 Select Header to insert a header at the top right

of the page.

Type Practical exercise using a header’.

4 Move your cursor to the bottom of the page
below the dotted lines to view the footer. There
should be no text in that section.

5 Click the Insert Page Number icon.

Click the Date/T'ime icon to insert the date.

7 Click Close on the Header and Footer toolbar or
double click on the main part of the document.

w

(=2}

8 You should see the added information on your

page. Alternatively, switch to Print Preview to
view your newly added header and footer.

Exercise 5: Footnotes and endnotes

1 Type the sentence “This is a footnote, not a

footer.’

2 Navigate to the References tab and select

Footnote (this option may be different in
previous versions of Word).

3 Select the Footnote option. The cursor moves

to the bottom of the page. Type ‘Example of a
footnote.” You have just created a footnote.




Creating tables

A table is a convenient way of grouping text in an
organised manner. It is constructed of cells grouped in
rows and columns. The height, width and borders of
these rows and columns can also be changed. Cells can
be merged (joined together) or split. The table below
shows a list of owners and the names and ages of their
pets.

Rashid Turtle
Jurnee  Dog 4
Jana Bird 1

The table feature allows you to select the number of
rows and columns needed. In an existing table,

one or more rows can be added above or below the
selected row, while one or more columns can be
added to the left or right of the current column.
Rows and columns can also be deleted, and cells in
the table can also be added or deleted to shift data in
the table up, down, to the left or right of the current
cell. This is achieved by placing the cursor in a cell in
the table and then right-clicking to show the various
table options.

'The design and layout of a table can be modified by
changing the type of border, the style of the lines and
the thickness of the lines in and around your table.
Rows, columns or cells can also be shaded in different
colours.

You can also apply limited summation and other
functions to a table in a word-processing document,
although this is not intended to replace the Excel
spreadsheet. While tables have replaced the old
method of using the 7a key to align data in columns,
sometimes you may need to convert some tabbed data
into a table. The Convert Text to Table option achieves
this, once the data is separated by tabs, commas,

paragraphs or a single specific character (Fig 5.16).

Tables and columns

Convert Text to Table ? X

Table size

Number of columns: 6

40 4

Number of rows
AutoFit behavior
(@ Fixed column width;  Auto
() AutoFit to contents
O AutoFit to window
Separate text at
@ Commas
O other:

O Paragraphs
() Tabs

Fig 5.16 Converting text toa table

Cancel

Creating columns

You can divide a page up into several parallel columns.
This is particularly useful if you want to produce a
newspaper, newsletter or a leaflet which could be
folded. Laying out text in two or more columns saves
space on the page.

The column feature can be created in the middle of a
page. With column section breaks placed in a column
format (Fig 5.18). Word will automatically put in

the column section breaks. Note that a column break
is used to stop text at the end of one column and
continue it in the next column.

ST .

Questions —

1 Describe one example of using a table in a word
processor.

2 [Explain the difference between adding a column

and adding a row to a table.

3 State the number of rows and columns in the table
shown in Figure 5.17.

Type ~ Name ample

Fish ~ Small  Flying
Fig 5.17 Example Fruit Seeds Cherries

of atable




5.3 Tables and columns

Video provides a powerful way to help you prove your point. When you click Online Video, you can
paste in the embed code for the video you want to add. You can also type a keyword to search online for
the video that best fits your document.

To make your document look professionally Video provides a powerful way to help you
produced, Word provides header, footer, cover prove your point. When you click Online Video,
page, and text box designs that complement you can paste in the embed code for the video
each other. For example, you can add a you want to add. You can also type a keyword
matching cover page, header, and sidebar. Click to search online for the video that best fits your
Insert and then choose the elements you want document.

from the different galleries.

To make your document look professionally produced, Word provides header, footer, cover page, and
text box designs that complement each other. For example, you can add a matching cover page, header,
and sidebar. Click Insert and then choose the elements you want from the different galleries.

Themes and styles also help styles, your headings change button for layout options

keep your document to match the new theme. appears next to it. When you

coordinated. When you click L . work on a table, click where
. Save time in Word with new

Design and choose a new you want to add a row or a

buttons that show up where
you need them. To change
the way a picture fits in your
document, click it and a

column, and then click the
plus sign.

Theme, the pictures, charts,
and SmartArt graphics
change to match your new
theme. When you apply

Mdeo provides a powerful way to help you prove your point. When you click Online Video, you can
paste in the embed code for the video you want to add. You can also type a keyword to search online for
the video that best fits your document. To make your document look professionally produced, Word

Fig. 5.18 The column feature can be used in the middie of your text

p
Practical exercises using Microsoft Word . \
Exercise 6: Creating tables 3 Save the document as ‘Competition’.

A Creata the table B Change the width of the table columns

1 Navigate to the Insert Table feature. Insert six 1 Make sure no part of the table is selected

) fi?lumr: and f:we ;OWS' I . 2 Move the mouse pointer to one of the vertical
ype the text in the table as shown. lines in the table until it changes shape to two
First  Last Company Fees Mem- Group arrows pointing left and right, with a pair of
nAme  name bers  # parallel lines between them «fl+.
Mom  Ium  teminglae SPSU ? * 3 Click and drag the mouse to move the gridlines
Cl_avery Lotte Team ALL $300 7 2 to increase or decrease the width of the columns
Mlisohy  Zacton! N-lrlane 175 3 3 ot the rows. Alternatively, some applications
Ross  Alien gﬂaSter 3300 8 3 allow you to double-click to adjust the width of a

amers

column.
| i




5 Word processing

e

C Sort the table
1 Select the whole table and choose the Sort

icon 2l .

2 Check that option Header Row is clicked.
Sort the table by Last name in Ascending
order.

3 Click OK to sort the table.

4 By selecting Header Row in the Sort dialogue
box, the header row (titles) will not be sorted
with the rest of the rows.

D Insert a row and add a formula

1 Place the cursor in the last cell in the Group #
column. Press 7ab. A new row will appear at the
bottom of the table.

2 In the first cell of the new row, type “Totals’.
Press Tab to go to the Fees column.

3 Select the Design menu option from the Table
tools and select the Formula icon. Check that
=SUM(ABOVE) is entered in the Formula
dialogue box and click on OK. Repeat for the
sum of the Members column.

4 Press Tab to go to the Group # column.

Select the Formula icon. This time change
=SUM(ABOVE) to =COUNT(ABOVE) in
the Formula dialogue box and click on OK.

Formula ? X

Farmula:
=COUNT(ABOVE)

Number farmat:

Paste function: Paste bookmark:

Fig 5.19 Add a formula to a table

E Change one of the Group # figures

1 Change the group number for Alison from 3 to 1.
2 Double-click on total for the Group #, using the
right mouse button, select Update Field to see

the result. Save the file as “Table Exercise’.

F Merging and splitting cells

1 Place the cursor in a cell in the first row with
the headings. Right-click and select the Insert
option. Select Insert rows above to insert a new
row above the headings of the table.

2 To merge all cells of the new row into one,
highlight all the cells, right-click and select
Merge cells from the Table menu.

3 Type ‘Registration for Gaming Competition'.

Centre the heading.

5 Note that once a cell is highlighted it can be split
by right-clicking in the row and choosing Split
cells from the Table menu. The dialogue box that
appears will allow you to choose the resulting

b

number of columns and rows.

Exercise 7: Columns

1 Open a blank word-processing document.

2 Type ‘=rand(6,3)’ (without the quotes) and press
Enter. Alternatively, type ‘Video provides a
powerful way to help you prove your point.”’ Copy
the sentence and paste it three times. Copy the
paragraph of three sentences, press Enter twice
and paste the paragraph five more times, pressing
Enter between each paragraph.

3 Select the first three paragraphs.

4 Navigate to the Columns icon. In recent versions
of Microsoft Word, it is found in the Layout tab
on the ribbon.

5 The Columns option box is displayed as shown

in Figure 5.20. »




5.3 Tables and columns

» 2 From the menu, select Insert, Break or, in recent
m versions of Microsoft Word, select the Layout
tab on the ribbon, select Breaks.
3 From the list, select Column Break.

Columns

The text moves and now starts from the second

I i B

One COIU mn.

Exercise 9: Unequal columns

With a column layout, it is possible to set unequal
sizes for each column.

Three

— el 1 Place the cursor in the left column at the start of
=] left paragraph 1. Click on the Columns option and
oi select More columns (in earlier versions, untick
s Equal column width).
2 Choose the Left column setting which makes
the left column narrow and gives the right

2| Right
|

== More Columns.. 1b¢

Fig 5.20 Creating columns column more width.

& Seleor Torsoohmmas 3 Maintain the spacing between the columns as

"

7 'The selected paragraphs will be subdivided into 0.5" Select OK.

two columns. If there isn't enough information i . =
olumns ;

for two columns, it will fill the left column only. ==

Th cument remains the same, except that _

8 The document re s the same, pt tha = v i Eﬂ] =
text reads down the left half of the page and = == = e =
continues on the right half. finber oreoknig 2 IR (] tine between

9 Select the fourth and fifth paragraphs. Use the WAGH) snd spacing ey

Col = Width: Spacng:
Columns option to create three columns. w | nes sl los .
z 47 = =

Exercise 8: Using column breaks - s

The column break is used only for subdividing text ] Equal column width

between CO].umn.S. &pply to: | Whole document

1 Place the cursor at the beginning of the fourth [ ] Cancel

paragraph. The cursor should be at the leftmost

column.

Fig 5.21 Formatting text with uneven columns




Before you print or share your document with others,
it is best to proofread it for spelling and grammatical
errors. You may also want to make comments that will
be useful later or for others to read when you share the
document. Other features such as Word Count and
Track Changes (knowing what has been edited by
yourself or others) are useful options when reviewing
your work.

Just as you would cross out, circle or make a comment
in a paper-based document, as well as check for errors,
word processors can easily perform these functions

for you.

Proofing language

Before you begin to review your document for spelling
errors, you may want to confirm the language that

you will use to proofread your work. For example,

UK English recognises the spelling of words
containing ‘s’ and %’ differently from US English.

'The language option also confirms whether you wish
to have the document checked for errors in spelling

or grammar.

Spellcheck

A spellchecker will examine your text and identify
any spelling mistakes. When a mistake is found most
spelling checkers will attempt to ‘guess’ what the
correct word should be and make some suggestions to
you. You can accept one of the suggestions or retype
the word correctly yourself.

Spellcheckers have quite large dictionaries with
thousands of words that are supplied with the word
processor. However, there will be some words that are
not in the dictionary, such as people’s names. You can
usually add extra words to the dictionary.

A spellcheck cannot spot mistakes where you have
typed the wrong word. For example, it will not

@ Reviewing your work

spot ‘their’ instead of ‘there’ or ‘the’ instead of
‘they’.

Your word processor starts spellchecking from

the cursor position and checks to the end of the
document. When the spellchecker reaches the

end of the document, a dialogue box opens, asking if
you want to continue spellchecking from the
beginning of the document. Spellchecks also find
repeated words.

The Spelling icon in the Proofing group provides
options for handling errors. You can select a range of
text and then click the Spe/ling icon to spellcheck only
that block of text.

Microsoft Word X

We're finished checking your selection.
Want to check the rest of the document?

Yes No

Fig 5.22 Spellcheckers can review an entire document or sections of it

Spellcheck options
Here is a list of the options available in the spellcheck
dialogue box, with their meanings:

+

Ignore Once: ignore word just this one time

+ Ignore All: ignore every one of the selected
words

¢ Add to Dictionary: if a word you type is not in the
computer’s dictionary it can be added

¢ Delete: delete a word if it occurs only once

¢ Change All: change all occurrences of a highlighted
word

¢ AutoCorrect: the computer will automatically
correct this word every time it occurs

+ Options: gives you many choices, such as changing

the dictionary language, ignoring uppercase letters

and words with numbers.



'!,Y = Yo ;. 4= TN G bha amall alaals dialam bhase satie dhoaie e s sl
&8 Spelli » explaini
SRR i >
explanation, clarifying, justifying
explanting "
| . [No reference information]
ry Paste Options:
= enplaning ,
A [No reference information]
= Translate Add to Dictionary
18 Link v lgnore All
<] New Comment B: See More
cxplsbing the benefits

Fig 5.23 There are options when correcting an error

Thesaurus and grammar check
Most word processors also offer thesaurus or grammar
check features. This is different from a spellcheck.

A thesaurus will suggest alternative words with the
same meaning as a word that you have typed in
(synonyms). For example, if you type ‘big’ the thesaurus
might suggest ‘large’, huge” and ‘vast’.

shia?
X Cut

B Copy

[y Paste Options:

e

0O

A Font.
= Paragrapnh...

Synonyms 4 large
52 Translate giant
e;é{_) Link > immense

{ §J New Comment vast
great

EE Thesaurus..

Fig 5.24 A thesaurus will suggest alternative words with the same meaning

A grammar checker will examine the structure of
any text you have typed and may highlight some

grammatical errors.

5.4 Reviewing your work

Word Count

The status bar at the lower left of a word-processing
document provides a summary of the number of
words in the document. However, for a more detailed
summary, the Word Count option in the Proofing
Group of icons shows the number of pages, words,
lines and characters in the document.

Word Count ? X

Statistics:
Pages 4
Words 738
Characters (no spaces) 3,663
Characters (with spaces) 4372
Paragraphs 42
Lines 73

Include textboxes, footnotes and endnotes

Fig 5.25 The Word Count feature summarises the number of pages, words,
characters, paragraphs and lines in the document

Tracking changes in your
document

'The Tracking feature is a useful way to monitor

any editing that you make to a document. When

this feature is used, every edit to the document is
highlighted. As you delete text, it will usually change
to a colour such as red with the text crossed out. As
you insert text, it also will be typed in a colour but will
be underlined. The Changes feature is used to review
each edit in the document so that you can accept your
changes or reject them and retain the original text.

|—__'_"__1, S All Markup - “—/Ii ;(‘ '] Previous
= [£] Show Markup ~ = == ] N
Track . Accept Reject
Changes * [5] Reviewing Pane ~ 3 4
Tracking ™ Changes

Fig 5.26 Sometimes it s useful to track any editing in a document




5 Word processing

Comments

Adding comments is an alternative to editing a
document directly or using Track Changes. It is also
useful if you are reviewing a document for someone
where the content is not being changed in any way.

A comment can be created by placing the cursor near

the text, then right-click and select New Comment.

An alternative method is to use the Review tab to add
and delete comments (Fig 5.27). Once more than one
comment has been added to the document, each can be
selected and responded to, or all comments can be viewed.

Mailings

Developer  Help

New  Delete Previous West
Comment -
Comments

Insert a Comment i ! 1
Revisio.., ~

= 2 revisions

MT
1 Commented
Courses or

workshops? Access and Alignment

MT M fpourses jumuoffered by thejwmiz) CPDLL, as well as
1 Commented

only CPDLL?

Fig 5.27 Comments can be inserted in a document using the icon in the
Review tab on the ribbon

Protecting a document

There may be times when you make changes to a
document and then save it, only to realise that you
need the original text. Most word processors have an
AutoSave feature that automatically saves your work
every few minutes. So, if your original document is
located on a secondary storage device, it will update
the file in that location with the latest changes as you
make them.

The Save As feature can also be used to avoid saving a
document and overwriting previous edits. If you have
made major changes to a document, use the Save As

option to create a copy of the updated document. You

can update the name of the document to include, say,
‘version1’, ‘version2’ and so on, or use the current date
in the file name so that you have multiple versions as a
backup until your document is finished.

Occasionally you may want to protect a document if
you are sharing it with others. If no changes are to

be made, the document can be saved as read-only or
marked as final. A password can also be used if it is to
be accessed by selected persons. Just ensure that you do
not share the password in the same email, for example,
as the password-protected document.

Users who have access to a document could also

have specific restrictions placed on it. This includes
preventing formatting changes, track changes,
comments, general editing, copying or even printing
the document. A higher level of protection involves
the use of a digital signature to confirm that the
document accessed is valid and has not be modified.
A digital signature can include a scan of a signature
or other information that confirms the validity of the
document.

Protect Document

Control what types of changes people can make to this document.
Protect
Document =

s Mark as Final
.

Let readers know the document is final and make it read-on

Encrypt with Password

Restrict Editing

wtrol the types of chanaes others can

Restrict Access
@ Grant peopie access while remo ng their ability to edit, copy, or print

Add a Digital Signature

M Ensure the integrity of the document by adding an invisible digita

gnatire

Fig 5.28 Documents can be protected using different options
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Questions

1 You have typed a document using a word processor.
State the most appropriate feature for each of the
following descriptions:

a will not detect whether'the! ‘their’or ‘there'was
used correctly

b will leave a deleted phrase in the document, but
with a tire-thretgh the text

¢ allows you to leave a note for a user’s attention

d a method to check the amount of text within a
specific limit.

2 Explain the difference between a spellchecker and a
thesaurus.

3 List three ways in which a document can be
protected.

5.4 Reviewing your work

Practical exercises using ¥

Microsoft Word

Exercise 10: Spellcheck

1 Type the sentence ‘Eli is taking the test for his
driver’s liscence.’

a Perform a spellcheck on the sentence.

b Right-click and select Synonyms from the
option box to find alternative words for
‘test’ and ‘driver’.

¢ Use the Word Count feature to summarise
the words and characters in the sentence.

d Use Track Changes to delete ‘is’from the
sentence and replace it with ‘was’.

e Inserta comment at ‘test’and type the note
‘Did he pass the test?
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It is useful to move information from one part of

a document to another and add information or

other documents or programs into word-processed
documents. If you are writing reports where some
pictures, tables or charts need to be included, you do
not have to leave spaces big enough to stick these
images in later. You just insert the files from other
programs (or copy and paste them) in the document
at the location and adjust the size of the images. A
limitation of some word processors is that they will
not allow you to arrange the information in especially
interesting ways. Remember that word-processing
programs are not designed to perform complex layouts
of combined information.

Combining files

Suppose you have three sections for an assignment in
three separate documents. One way of combining a
few documents is by using the copy or cut and paste
features between documents. Note that you first need
to have opened all necessary documents.

1 Select the document that has the text you wish
to cut or copy from. Select and Cut or Copy the
text.

2 Go to the document where you want to place your
text.

3 Click the cursor at the desired location and Paste
the cut or copied text.

Sometimes you may have two documents containing
comments or edits that need to be combined into one
final document. Another useful method is the Combine
Documents feature. This creates a new document that
highlights all edits as tracked changes. If you have
several documents that need to be combined, start with
combining two documents, then the new document
can be combined with another document, and so on.
With this feature you can select what should be viewed
or hidden from view in the new document such as

updated tables or formatting.

Combining files and importing data

Importing data
File types

How do you make sure that the information created
by one program will be understood by a different
program? When you save your work, you will probably
give it a name and then click OK. Look carefully at
the box that then comes onto the screen and you will
see a drop-down menu from which you can choose to
save your file in a different format. Sometimes you may
need to open or save a file as a type that is different

from the one the program you are using will do by
default (Fig 5.29).

'The simplest common file type is TEXT (TXT is the
file extension). All word-based programs will be able to
open a TEXT file. There is a problem with TEXT files,
however. They save only the words. They do not save
the font, style and formatting information. Hence, the
information does not look the same when you import
it into a Word document, and you have to repeat all
the appearance settings or formatting.

Rich Text Format (RTF) was designed to overcome
this problem. It saves the font, style and formatting
information, as well as the words. When you import an
RTTF file into another program, it should look the same
as it did in the program that created it.

} 754 PM

I 754 PM

§ 10:50 PM

} 756 AM

) 948 AM

Fig 5.29 You can save a file in different formats



5.5 Combining files and importing data

There are many other file types which are specific of the screen. As an alternative to using the Task Bar,
to particular programs and you may well be able to some users prefer to use A/t + Tab to switch between
import these also — but you will need to check before applications. To do this:

you try any of them. If they are incompatible your text 1, “Eiold dewn the.f ey

2 With the 4/t key held down, press the 7zé key until

ey you see the name of the application you want.

may appear garbled when viewed (Fig 5.30).

3 Release the A/¢ key to switch to that application.

Excel is a spreadsheet program that makes number
crunching, organising and presenting data very easy —
even for the mathematically challenged.

To insert an Excel worksheet, for example, into a Word
document, once the data already exists in an Excel

spreadsheet, open the spreadsheet, select and copy the
Fig 5.30 Incompatible file formats can lead to unreadable text text, switch to Word and paste the copied text. Word
converts the data to a table format.

Switching between applications

To integrate data from different applications it is often Questions

necessary to have all relevant applications running and 1 Explain two ways of joining information in two

to switch between them. For example, you can switch documents into one final document.

between open Word and Excel files by selecting the 2 FExplain why a user would want to switch between
application’s button on the Task Bar at the bottom different programs.
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Long documents that contain many headings should
have a table of contents. A table of contents is usually
found near the beginning of a document. As shown in
Figure 5.31, it is not actually a table, but a list of short
headings that describe the different sections in the
document. These headings are in order as they appear
in the document with the page number to locate each
section.

Table of Contents

RECOSE oo cciniascm e o S S e R e e 3
Alignment. o cananiuun e srnunans s 4
Thia launich OF the Caie. ..o 10
Opportunities for students.........c.cceevereeeeernnnenn. 17
University of first choice .....cccovvveeveecrienereeccennnnns 18
RegIStratiOnNS:: . oo tmme e e e, 22
ASSBSEMIBIE coiciiviivoi siossii v oo s 25
Dual certification ..., 30
5] 511 £ S 35
SUMINATY woanmnsumisi sl

Fig 5.31 A table of contents provides an overview of the document’s contents
and how it is organised

Selecting headings

Typing the headings and page numbers to create a table
of contents can be time-consuming, especially if you
need to add or modify a heading after it has been created.
Fortunately, every word processor has this feature.

One of the easiest ways to create a table of contents

is using a style. A style is a simple way to apply a
specific font style, size and colour to selected text in
one step. If the main headings in a document should
be Arial, 14 point and black in colour, while another
heading should be Arial, 12 point and black, then

you can select each heading and choose the required
style with one click. This is much faster when
compared to selecting the font, then the size and
colour for the heading. Figure 5.32 shows some of the
styles that are available, with labels such as Heading 1,

Table of contents

Heading 2, Title, and Subtitle that suggest where
they can be applied.

AsBbCcDd AsBbceDd AaBbCi AaBbcel AADB  assbeed
5 Title Subtitle

TNormal ¥ No Spac Heading 1 Heading 2

Styles

Fig 5.32 Using styles simplifies the creation of a table of contents

Generating the contents list

Once the styles have been applied to the required
headings, the table of contents can be generated. First,
place the cursor near the beginning of the document or
where the contents list should be placed. Then locate the
Table of Contents icon (Fig. 5.33) and select a suitable
table from the menu (Fig 5.34). The contents list is
generated at that location. If different styles were selected,
then you will see the various levels indented in the list.

=% T2 Add Text~

== [lupdate Table
Table of

Contents =
Table of Contents

Fig 5.33 Group of icons
for generating a table of
contents

=5 T Add Text - 1

: ; i 4
| Update Table AE Next Footnote ~
Table of Insert Insert

Contents - Footnote Citation «
Built-In

I[;} Insert Endnote

Automatic Table 1

Contents
Head g | |
Heading 2 i y 1
Heading 3 1

Automatic Table 2

Table of Contents
Headmy | i
Heading 2 1
Headmg 3 5 ]

Manual Table

Table of Contents
Type chapler tithe level 1)
Type chapier tnhe (level 2)
Type chapier title (level 3)
Type chapier tithe (level 1)

T

Fig 5.34 Options for generating a table of contents



Linking to a page

The contents list shows each heading and its page
number. The contents list can be used to navigate to
the actual page where the heading is located for that
section in the document. For example, to go to the
page with a heading entitled ‘Cohorts’, hold the C#/
key while tapping the line for ‘Cohorts’ (Fig 5.35).
'The word processor locates the page and places the
cursor at that heading in the document.

Registrations......ccoeveiiiiiiiieiiiiecereeeeieee e e 22

ASSOSEMIONT . oo s ks s 25

Dual Current Document
Ul Ce1ctri+ Click to follow fink ===+ ==ssseees

COROTES s s S S TR e 3D

Fig 5.35 The Ctrl + Click key combination navigates from the contents list to
the select page

Updating the contents list
If you wish to add another heading to the table of

contents, select the heading and apply the appropriate
style, then return to the contents list and select one of
the Update Table options. A dialogue box prompts you

5.6 Table of contents

to either update the page numbers only, or the entire
list to include the new heading (Fig 5.36).

Tab Update Table of Contents ? X

| Word is updating the table of contents. Select one of the following

|
options: L
l
E

©§Update page numbers onlysf
() Update entire table

s I
.

Fig 5.36 The page numbers or the entire list in the table of contents can be
updated

Deleting one or more headings from the contents list
is also achieved using the same Update Table option.
The table is updated with the remaining headings and
updated page numbers.
=
| Questions
1 List the main steps required to generate a table
of contents. Use the styles only for Heading 1 and
Heading 2.
2 Ifanew section is added to a document, what are
two methods that can update the table of contents?

| = ad

Exercise 11: Table of contents
1 Using the headings in Figure 5.31, make a
document with each heading on a new page.

the document.

heading. Then press Enter twice and add a
heading called Fees.

Generate a table of contents placed at the start of

2 Use Ctrl + Click to navigate to the Registrations

Practical exercises using Microsoft Word N\ !

3 Return to the table of contents list and update
the table.

4 Use Ctrl+ Click to navigate to the Cohorts
heading. Delete this heading.

5 Return to the table of contents list and update
the table.




Mail merge

Why Mail Merge?

Sometimes a business will want to send a standard
letter to a lot of people but each letter has to be slightly
different in some way. For example, if a business were
to send out reminders for unpaid bills then the letters
would be identical except for the customers’ names and
addresses and the amounts owing.

This could be done by typing the standard letter, saving
it, and then making all the changes needed for each
customer. The editing facilities would make this easy

to do — delete the name and address and other details,
and then type in the new information. But it would be
a very tedious and repetitive job, especially if there are
hundreds of letters to be edited.

Secondary document
with list of data

Mail merge is an advanced feature in most word
processors. Such programs automate this type of
job and reduce the repetition. You must create two
documents: one is a list of the details such as the
names and addresses of the people you want to
write to; the second is a master letter, with markers
where the details are to be added. When these two
documents are complete (and correct), you choose
the merge function. This produces as many letters as
there are people in the list by putting the appropriate
information into the spaces marked in the master
letter. This saves a lot of time. Along with letters, the
creation of labels and printing envelopes are popular
uses of mail merge.

Dear Mala,
Thank you for your response. Please find your login information below:
Your username is: Maltu

* Your password js: Tuim

Dear Clavery,

It you 4 Thank you for your response. Please find your lagin information below:

Reme * Your username is: Clalo

* ‘Yaur password is: Lotte

Merged letters-
One letter for each __

Paragraph E| Slyles
....... 2 R P A | 5 R
- /
Firstname | Lastname | Company | Username fPassword ] Group /
ElE] Tuirm Gaming Inc. altu 4 1
Clavery Latte Tearmn ALL Clalo Lotte e
Alisan Zacton MN-Ta-Tane Aliza Zacto 3 L
Ross Allen Master Gamers rasal allen 3 \.
Paragraph =] Shyles
R T T R A e 5 WSS
oo (S )

Thank you for your respanse. Please find your login information below:

* Your username is

» Your password is le<First_Nare>>}

Primary document
with merge fields

If you are unable to log in, please respond to this message to have the password reset.

Rermember the workshop will be visible on Apr 28 at &pm ECT

Fig 5.37 Mail merging lets you make many personalised letters from a list

person in the list

Dear Ross,

Thank you foryour response. Please find your lagin information below:

If you 4

Reme )
* Your username is: rosal

# Your password is: allen

If you are unable to log in, please respond to this message to have the password
reset. Remember the workshop will be visible on Apr 28 at 6pm ECT




There are four main steps that must be followed to
create mail—merged letters.

1 Create the list: If the list containing the names and
addresses of the people to send the letter to does
not already exist then it must be created.

2 Write the letter: The letter to send should be created
in the word processor. Special codes must be placed
in the letter where the names and addresses of the
customers should appear.

3 Link the letter and list: These two documents must
now be linked together so that the Mail Merge
function knows which file contains the names and
addresses to put into the letters.

4 Perform the mail merge: When the mail merge is
performed, one document is produced containing
one letter for each person in the list. The names and
addresses will be filled in on each letter.

Businesses, clubs, schools and other organisations
use this method of personalising correspondence to
circulate individualised information.

Selective mail merge

When letters are sent to only some of the people in a
list, this is called a selective mail merge. Selective mail
merges are much more useful than simple mail merges,
which produce letters for everyone in a database.

For example, a club could select the names of people
who need to renew their membership from a database
of members. Mail-merged reminder letters could then
be sent to these people.

Using Microsoft Word to perform
a mail merge

Part 1: Creating a letter, label, or envelope
1 Navigate to the Mailings tab (Fig 5.38), then
select the Mail Merge or Start Mail Merge icon.

Home Insert Design References

Layout

Review

5.7 Mail merge

Alternatively, select the wizard if you are new to
using mail merge. A task pane will appear on the
right of the Word document. Choose one of the
types of documents: Letters, Envelopes or Labels.

Part 2: Setting up data records
The process of selecting recipients is identical for
creating envelopes and labels. In the Mailings tab:

1 Click Select Recipients.

2 Select Type a New List.

3 In the New Address List window (Fig 5.39),
type the data that is relevant to your letter under
each field; for example, title, name and address
information. You do not have to fill in every field.
Click on the Customize button if you want to add,
delete or rename any field.

4 To make another entry, click New Entry. Add all
the data, one set at a time.

5 When you have finished entering all of your data,
click OK.

6 In the Save Address List window, save the file for the
data list by putting a name in the Filename field. This
list is usually saved in the My Data Sources folder. You
can save your list somewhere else but remember the
location so that you can find it for the final mail merge.

7 Click Save.

8 Select Edit Recipients List. The contacts in the
new list will appear in the Mail Merge Recipients
window where you can edit the list if you need
to. Note that you can also browse for a list that
is already saved to use as your data, using Select
Recipients by selecting Use an Existing List.

View Developer Help

[5 Rules - e M € as L I ESN

o e/ | ¥ -
el - : - & Match Fields . [JDFind Recipient o
Envelopes Labels Start Mail  Select Edit Highlight Address Greeting Insert Merge Preview ° Finish &
Merge - Recipients - Recipient List Merge Fields Block  Line Field - Results |« Check for Errors Merge -
Create Start Mail Merge Write & Insert Fields Preview Results Finish

Fig 5.38 Mail Merge functions are on the Mailings tab




5 Word processing

New Address List ? X
Type recipient information in the table. To add more entries, click New Entry.
Title w |FirstName «|LastName «|CompanyName w|Addressli.. w|AddressLi.. «|City w | State
| |Dr. Eli Hunte YT Gamers
P Gaming Group
< >
New Entry Find...
Delete Entry Customize Columns... oK Cancel

Fig 5.39Adding details to the New Address List for the mail merge

Part 2A: Manipulating your data

In the Mail Merge Recipients window, you can select
specific records by checking the boxes next to each
recipient, or if there are a lot of recipients you can
click the arrow next to the column heading to select a
particular category in that column. If the arrow next to
any column heading is blue, that heading has selected a
particular category already. To check all names in your
recipients list, click Select All. To uncheck all names,
click Clear All. To sort the list, click the column
heading of the item you want to sort by. When you
have finished selecting your data for the merge, click
OK to return to the Mail Merge Wizard.

Part 2B: Data sources you can use with Word
¢ ASCII text files

¢ Microsoft Word documents

¢ Microsoft Excel files

¢ Microsoft Access files

+ Qutlook contact lists.

Part 3: Completing the letter, label or envelope
You can now type your information on the page.
Be sure to insert the merge fields where you want
to merge names, addresses and other data using the
recipient list. To insert a field:

1 Place the cursor at the appropriate position in the
main document.

2 Click Insert Merge Field or, if using the Step by
Step Mail Merge Wizard, select the More Items.

3 In the Fields window, click the field you want.

4 Click Insert, and then click Close.
5 Repeatsteps 1 to 4 until all the fields are inserted
into the main document.

Part 4: Completing the merge

1 Before previewing labels, click the option to
replicate the layout of the labels.

2 Click Preview Results to view your letters, labels or
envelopes.

3 Click Finish & Merge.

Click Edit Individual Documents.

5 In the Merge to New Document window, select the

L

records you want to merge:

a  To merge all the documents, click AlL

b To merge only the document that you see in
the document window, click Current Record.

¢ To merge a range of documents, click From,
and then type the record numbers in the From
and To boxes.

6 Click OK.

Microsott Word will create a new merged document.

~J

8 Print or save the document just as you would any
other document.

Microsoft Word will open one new document that
contains all the individual letters that were merged.
Under most circumstances, you do not need to save the
merged document. It is more useful to save the main
document and merge it again if you need to. However,
for your SBA you need to save the document just as
you would any document for grading.



5.7 Mail merge

1 |dentify two benefits of the Mail Merge feature.

2 State two documents that can be produced with the

Mail Merge feature.

3 Why is selective mail merge useful?
4 Give one advantage of using different types of files as

data sources.

5 State three choices of output for a merge document.

6 Explain three ways of selecting records to merge to a
new document.

Practical exercises using Microsoft Word

Exercise 12: Performing a mail merge

1 Create the letter shown and save it as

WORKSHOP.

2 Create the Word data source. The field names for

the data source should be: Firstname, Lastname,
Company, Username, Password and Group.
Include the records below and name the data file
INVITEES.

3 Merge to a new document.

4 Retrieve the WORKSHOP file and perform the

merge again to all persons in the list in Group 2.

INVITEES
Firstname Lastname Company
Mala Tuim Gaming Inc.
Clavery Lotte Team ALL
Alison Zacton N-Ta-Tane
Ross Allen Master Gamers

N

WORKSHOP

Dear «First_Name»,

Thank you for your response. Please find your login
information below:

¢ Your username is: «username»
+ Your password is: «password»

If you are unable to log in, please respond to this

message to have the password reset.

Remember the workshop will be visible on Wed at
6pm ECT.

Username Password Group
Maltu Tuim 4
Clalo Lotte 2
Aliza Zacto 3
rosal allen 3
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a
Exercise 13: Creating a set of labels

1 Use the same data as in Exercise 12 to create a
set of labels of your choice.
2 Place the field names on the label as shown

below:

«First name» «Last name»

Group «Group»

3 Name the document with the merge fields as
Labels.

4 Before previewing the labels and completing
the mail merge, click the option to replicate the
layout of the labels.

5 Name the final merge as LabelsM.

Exercise 14: Creating a set of envelopes

1 Use the same data as in Exercise 12 to create a
set of size 10 envelopes (4 1/8 X 9 1/2 inches).

2 Place the field names on the envelope as shown
below

«First name» «Last name»

C/o «Company»

Mail Merge ~ X

Arrange your labels

If you have not already done so,
lay out your label using the first
label on the sheet.

To add recipient information to
your label, click a location in the
first label, and then click one of
the items below.

D Address block..,
[i'l Greeting line...
|__|'§' Electronic postage...

= More items...

When you have finished
arranging your label, click Next.
Then you can preview each
recipient's label and make any
individual changes.

[ Replicate labels )

You can copy the layout of the

first label to the other labels on
the page by clicking the button
below.

Update all labels

Step4 of 6
=» Next: Preview your labels

€= Previous: Select recipients

Fig 5.40 When creating labels, you need to update the layout before merging




In order to print your document, select the File and
Print commands (or C##/ + P) found on many word
processors. This sends the document to the default
printer. There are various print options that you need
to know, once you have finished your document.

Print Preview

The Preview option enables you to take a different
look at your document. The document you see on the
monitor will generally look the same as the printed
result. This includes features such as footnotes, headers
and footers, page numbers, multiple columns and page
breaks. Note, however, that if your printer can only
print in black and white, characters will be displayed in
colour on the screen but printed in black and white.

The good news is that you do not have to print your
document in order to review it. The Print Preview
command displays all the features of the printed page.
This allows you to scroll through the document using
the scroll bar slide or arrows or the PgUp and PgDn
keys.

You can also choose to quit Print Preview by tapping
the Esc key on the keyboard to return to the document
or print the document if there are no changes.

Print range

This option lets you indicate the pages of the
document that are to be printed. You can choose to
print the entire document page, one page or selected
pages. Once you select the print option you want, the
print command sends the job to the printer.

Copies

This option lets you indicate the number of copies to
print, and whether multiple copies are to be collated
(printed in order) or grouped (all page 1, then all
page 2 and so on).

Printing the document

i Copies: |1 =
Print
Printer

HP Laser)et Pro M12w_1

b
% Ready

Printer Properties

Settings

“__L Print All Pages

The whole thing

Pages
‘;.-_:; Print One Sided
| -
I=! Only print on one side of the p...
lEI_D Collated =
123 123 123
‘ L‘ Portrait Orientation v
r— Letter
L a5"x 11"
@ Normal Margins
v
-1 Left: 1" Right: 1"
lj 1 Page Per Sheet -

Page Setup

Fig 5.41 Options when printing a document

Questions
feature,
Preview commands?

document are to be printed.

copies of a document.

1 State two ways in which you can activate the print
2 What is the difference between the Print and Print
3 Name the three ways of indicating which pages of a

4 Explain two ways in which you can print several




Fillable electronic forms

A fillable electronic form is very useful for gathering  Table 5.3 Content controls for fillable forms
information in soft copy. It can be emailed or

completed online without having to re-enter the

data. It can also be completed on a computer, laptop ™ Users can type multiple paragraphs

or mobile device. Fillable forms can be used for

online quizzes, surveys, online registration, sign- A2 Plain text Users typelimited amount of text

up sheets, paying income tax online and online Check box Used for options: clicking in the box places
job applications, for example. They are better an X in the box to select the option

than paper-based forms because the fields can be T Combobox  Select from list of choices or type in
formatted to accept only the required data. For information

example, fields can be formatted to accept text, 7 Drop-down  Only select from list of choices

dates, yes/no responses or an option from a list. list

77 Date picker Browse to insert a date or select today for
current date

|74 Design Mode ~Used to customise the text on a form

Command Used in advanced forms to submit the
button form for processing. These buttons may
be labelled as Submit or Click OK

Creating a fillable form

The following steps explain how to create an electronic
form using Microsoft Word.

Fig 5.42 Online fillable forms can be completed using a mobile device Add the Deve lO per tab to d.is play the
There are some applications that specialise in creating content controls

fillable electronic forms, however we will focus on Microsoft Word uses the Developer tab to display the
designing forms using Microsoft Word and Google content controls. However, as it is hidden by default,
Forms. it must first be added to the list of visible tabs by

The most common controls and their icons which customising the ribbon. The steps.pay differ s]ightly based

are used to create fillable forms are described in on the version of Microsoft Word you are using. Once the

Table 5.3 Developer tab has been added, the list of content controls
o will be available to create your fillable form (Fig 5.43).

File Home Insert Design Layout References Mailings Review View Developer Help Q Tell me what you

Q- r 2 Record Macro ’ B [5=| AaAa = b Design Mode "ll:-';_‘ ‘ .y m
Visual Macros g Add- Word COM _ _ i XML Mapping Restrict Document
Basic 1. Macro Security ins Add-ins Add-ins (o &~ . Pane Editing Template

Code Add-ins Controls Mapping Protect Templates

Fig 543 The Developer tab must be added before a fillable form can be created




Open a template or create a blank
document to design the form
Microsoft Word has many online templates that can

be used to help you design your form. Once you are
online this feature allows you to search for templates

in various categories for business, education or sports.

However, you can also use a blank word-processing
document to create your own form as shown in

Figure 5.44.

NEW SERVICES FORM

CUSTOMER NUMBER 12-15896
CUSTOMER’S FIRSTNAME ADDY
CUSTOMER’ § LASTNAME PLIT

FAYMENT METHOD & Cash [ODebit Card CCredit Card

NEW SERVICE REQUIRED ADDITIONAL CLOUD STORAGE
SIGNATURE Addy Plit
DATE 4/28/2020

Fig 5.44 Sample online form with information added

Add content to create the form

Depending on the content, you can create a table

to type the text and controls in the various cells to
organise the layout of the form by aligning the labels
and content controls. A form can have multiple check
boxes, text boxes, date pickers and drop-down lists,
based on what information is required on the form.
You should increase the font size for headings and use
an appropriate font style, such as Times New Roman
or Arial.

Content controls

For any form, you will need to know the different
content controls. These allow you to enter specific
types of data in the form. Content controls include
check boxes, text boxes, date pickers and drop-down
lists, and more advanced features such as command
buttons.

5.9 Fillable electronic forms

Aa Aa = F5 B Design Mode
Bl E Properties
Fig 5.45 Content controls are [g f&"? a
used to create fillable forms in
Microsoft Word Controls

Set or change properties for content
controls

For each content control, the properties icon can be
used to format how the data will be presented. For
example, it is used to enter the options for a drop-
down list, or how a date will be displayed.

Customise the labels of the form
Clicking the Design Mode icon allows you to

customise the generic labels for the content controls.
For example, if the generic label for the text content

control is ‘Click here to enter text’, you can modify it
to ‘Click here to enter your last name’.

Protect the form

Once your form has been designed, you are ready to
share it with others and gather some responses. Select
the entire form and click the Restrict Editing icon oo
in the Developer tab to prevent others from modifying
the layout of the form.

Google Forms

Creating a Google Form is useful since it is created
online and can be easily emailed or shared with others.
Responses can also be viewed as soon as the user clicks
the submit button and the data can be downloaded to
a spreadsheet. These online forms can also be created
using Google Drive or accessed by entering
www.google.com/forms in a search engine.

You should name your form and then select the first
content control for the first question.
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Sample online form

Exampile of option bos content control

= Short answer
= Pamagraph
— Tl
The term ‘am'’ refers to ® Mot
Anoen Checkboxes
T ° Dropdown
Marme
o O Fileupload
Night
=== Linear scale
ses
221 Multiple choice grid
0 55 Checkbox grid
G Date
O Time

Fig 5.46 Example of a Google Form using a content control for a multiple-
choice question

Note that the Google Form can also be shared via
Google+, Facebook, and Twitter, and sent as an
attachment to the user’s email (Fig 5.47). As the form
is submitted, individual responses or a summary of
responses can be viewed (Fig 5.48).

|

Having trouble viewing or submitting this form?

FILL OUT IN GOOGLE FORMS

I've invited you to fill out a form

New Services Form

Online Form To Request a New Internet Service

New Service Required

v

| Submit |

Powered by

H Google Forms

This content is neither created nor endorsed by Google
Report Abuse - Terms of Service - Additional Terms

Fig 5.47 Google Form received as an email

3 responses

QUESTIONS

RESPONSES n

SUMMARY INDIVIDUAL

New Service Required

@ Dais Plan
@ Additional Cloud Storage
@ Internet

Fig 5.48 Responses received via Google Form




5.9 Fillable electronic forms

vUestiions

1 Explain one advantage and one disadvantage of 3 Order the following steps for creating a fillable form:
paper-based forms and online forms. i Protect the form.
2 Explain the difference between each of the ii Add content to create the form.
following: iii Customise the labels of the form.
a rich text and plain text content controls iv Add the Developer tab to display the content
b combo box and drop-down lists. controls.

v Open a template or create a blank document to
design the form.
vi Set or change properties for content controls.

A

Practical exercises )
Exercise 15: Adding the Developer tab 2 Create a table with two columns and eight rows.
These steps depend on your version of Microsoft 3 Type NEW SERVICES FORM in the first row.
Word. You can use a browser to search for ‘Adding Then merge the two columns in the same first

the Developer tab’. row.

4 Type the information in the left column and
1 Open a blank document.

2 Click File and then Options. Alternatively,
click the Quick Access toolbar and select More

apply content controls in the right column as
shown in the table below. Change the font style
to Arial and the font size to 10 or 12 point.

Commands.
3 Click Customize Ribbon. NEW SERVICES FORM
4 Lool for the Main Tabs list and select the CUSTOMER NUMBER Plain text content control
Developer check Box. Click OK. CUSTOMER'S FIRSTNAME | Plain text content control
CUSTOMER'S LASTNAME | Plain text content control
PAYMENT METHOD Check box content control

Exercise 16: Create a fillable form using 9 g
then type 'Cash’

Microsoft Word
Check box content control
1 Let’s use a blank document to create a form then type ‘Debit Card’
based on Figure 5.44.The online form is for Check box content control
customers who are applying for a new Internet then type ‘Credit Card’
service. NEW SERVICE REQUIRED | Drop-down list content
control
NEW SERVICES FORM SIGNATURE Plain text content control
CUSTOMER NUMBER il tar tevt
STONER’ S TIRETIE Targ R e DATE Date picker content control
CUSTCMER'S LASTNAME Clicl tap here to enter texi
ol Ol Cash TiDebit Card _ DCredit Card 5 A drop-down list is used for the service required
NEW SERVICE REQUIRED Choose m,__,_wm,ﬁ )
STGNATURE _ question. Add the content control box for the
DATE ADDITIONAL CLOUD STORAGE d d i
INTERNET — rop-down list.
DATA PLAN 6 With the drop-down list still selected, click on

Fig 5.49 Example used for creating a fillable form in Microsoft Word the Pr operties option 1n the D eveloper tab.

l k‘
Wi
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w

options to the list (Fig 5.50).

General
Title:
Tag:
Show as:  Bounding Box |~
Color: _”.‘_ i g
] Use a style to format text typed into the empty control

Style: |Default Paragraph Font| v

A dialogue box will show so that you can add the

] Remove cont
Locking Display Name: 'DATA PLAN|

DATA PLAN

[] content contq ¥alue:
[] contents cant

Drop-Down List Propermes
| Display Name Value ¢
|Choose an item, |
ADDITIONAL CLOUD STORAGE ADDITIO|

INTERNET INTERNE;

oK Cancel

Fig 5.50 Adding options to the drop-down list

7 Click on Add in the dialogue box to add
INTERNET. It will appear in the Display
Name and Value areas. Click OK.

8 Click Add again, to add ADDITIONAL
CLOUD STORAGE. Click OK.

Add Choice ? X

9 Click Add again, to add DATA PLAN. Click
OK.

10 Click OK to close the drop-list dialogue box.

11 In the Developer tab, select Design Mode to
edit the different control options. Replace each
of the content controls as shown in Figure 5.51.

NEW SERVICES FORM

CUSTOMER NUMBER

CUSTOMER'"S FIRSTNAME

CUSTOMER’S LASTNAME

FAYMENT METHOD
’ O Cash | [0 ‘Debit Card

] Credit Card

NEW SERVICE REQUIRED

SIGNATURE

DATE

Fig 5.51 Example in Design Mode to edit the text

12 Click on Design Mode so that you can edit
and customise the labels of the content controls
as shown in Figure 5.52. To preview the form,
click on Design Mode again.

13 Select the entire form and click the Restrict
Editing icon in the Developer tab to prevent
others from modifying the layout of the

form.

14 Test the form. Type 120163-03 as the customer
number, your first and last name, data plan as
the option from the drop-down list and select
the current date.

Label Design mode of content control

Replace with

CUSTOMER NUMEER

Click or tap here to enter text. Click or tap to type Customer number

CUSTOMER' S FIRSTNAME

Click or tap here to enter text.

Click or tap to type first name

CUSTOMER'’ S LASTNAME

Click or tap here to enter text.

Click or tap to type last name

NEW SERVICE REQUIRED

Choose an item.

Choose type of service

SIGNATURE

Click or tap here to enter text.

Click or tap to type signature

DATE

Click or tap to enter a date.

Click or tap to select date

Fig 5.52 Editing the textin the form




5.9 Fillable electronic forms

w

Exercise 17: Create a Google Form

1

w

Ensure that you have a Google or Gmail account
for this exercise. '

Type www.google.com/forms in a browser.
Select a blank form.

Create the same form as shown in Figure 5.51.
To add a new question, click the plus (+) to the
right of the form.

QUESTIONS

New Services Form

Qnfine Form To Reguest 3 New Ineme! Service

New Service Required @

1. Data Plan

2 Additonal Oloud Storage

...:“' I

1 Internet

4

D ®

Reqguired

Fig 5.53 Exercise — Creating a Google Form

5

Click Settings in the top corner to preview the
form.

6 Add your email address to test the form. Click
the option to ‘Include form in email’. Click Send
to email the completed form (Fig 5.54).

[] collect email addresses

Send via B n B

Email

itforcsec@gmail.com

New Services Form

I've invited you to fill out a form

Include form in email

CANCEL SEND

Add collaborators

Fig 5.54 Exercise — Emailing the Google form

7 Check the email of the Google form. Complete
the form and submit it.




° End of chapter exam-style questions

Multiple choice questions 7 A list of short headings that describe the different
sections in the document along with their page
numbers is called a:

1 Each of the following are methods of editing text in
a document, except:

a importing and exporting a Cohjxmn

b moving and copying b mgﬂ merge

¢ Find and Replace ¢ primary document
d spelling and grammar. d table of contents.

8 Sending a document to only some of the people in
a listis a feature in;
a selective Mail Merge
Find and Replace

2 Text that is lowered to just below the line and
printed at a smaller size is referred to as:
a alignment

b indent b ‘ ‘
¢ subscript ¢ moving and copying
d superscript. d password protection.

3 The feature that will look through the document Quiestions 9.and 10 referto Rigure 5.5,

to find one or more words that you specify and User_ Access EN
automatically change it with another word is called:
a copyand paste

Enter Login Name:

b dfag aﬂd drop Enter Password: Passwords must have no less

. than 8 characters including
< Flﬂd and Repiace 1 number and 1 special character
d spelling and grammar. Re-enter Password:

4 Text which appears at the top of each page but
inside the top margin is called a(n): Cancel Next->
endnote '

b footer
¢ footnote
d header,

Fig 5.55

9 Two content controls used in the form are;

5 The feature that highlights any editing that you 8 depaobiistand command bt
; b command button and rich text
make to a document is called: ;
¢ plain text and command button
& R d rich text and drop-down list
b spelicheck P '
€ leahtenge 10 The content control where users type only a limited
d Word Count. P Y

amount of data is called (a):
a rich text

b plain text

¢ check box

d drop-down list.

6 A document can be protected by each of the
following features, except:
a password
b read-only
¢ Markas Final
d Save A




Short answer questions
11 Oliver finished a report on his computer and saved it

5 End of chapter exam-style questions

12 Catherine needs to send a copy of a letter (Fig 5.56),
along with a proposal document, to 15 potential authors.

as Report_OT.docx.
a Name two input devices that would be useful o
for him when working on the report. — s
b What does .docx in the name of the report i it
represent, and what type application was used o ;[:myt
create the report? Wl e et 0 e s 01 S a1 o ApEPe i oot v 5
¢ The nextday he wanted to update it butkeep a ot e
copy of the original report. Describe how he could
create the updated report.
d Explain how Oliver can add a graphic to the cover . S
page of his report.
e The report needs a table of contents. ) &
i Explain why a table of contents would be %
useful for the report. S petos1718
ii Explain where the table of contents should
be placed in the report.
iii Write an example of a suitable table of 90
contents containing the following titles: a Her assistant wishes to use the Mail Merge feature
Introduction for this letter.
Updates to the project i State the two main documents required for
Additional staff Mail Merge.
Assignment of new staff ii Apart from the address in the letter, identify
Location of new staff at least five fields which will change in the
Summary document shown above.
f Oliver now wants to send the updated report to iii Name two other applications that can be
10 of his colleagues. used with Mail Merge.
i Explain how Oliver can protect the report so b Thefollowing data was saved in a file called ‘Authors!
that no one can make changes to it. i Name the feature that was used to create the
ii List two methods that he could use to send format for the data.
the report to his colleagues. ii Il the list was sorted in ascending order by
iii Describe one disadvantage of each method. Authori#, which author's first name would be
at the bottom of the list?
¢ Use your word-processing application to create
the letter and list of data. Then use the Mail Merge
feature to create envelopes of size 4 1/8"x 9 1/2"
for authors only assigned to Rod.
Author# |Title | LName FName Address Editor Email ResponseDate
131 | Mr Birnbaum Steve 2042 Drive Rd | Radi rachel@unipress.org 08/31/2019
230 | Mrs | Bradhurry Eleanor 9 Rogers Hill Gena geneva@unipress.org | 08/15/2019
727 | Mr ChuChu Tzay 147 Dia St Rod rod@unipress.org 08/15/2019
520 | Mr Fosten Terence P. 0. Box 881 Gena geneva@unipress.org | 08/01/2019
750 | Ms Rhone Jos P.O. Box 98 Rod rod@unipress.org 08/31/2016
622 | Sis Stens Cecile 127 Pacif Lane | Raci rachel@unipress.org 08/15/2016
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WEB PAGE DESIGN

{\Q Introduction to web page design

A web page is a document you can view using a browser.
It may contain text, images, videos and hyperlinks to
other web pages and files. Web pages are usually written
in a language called HTML (HyperText Markup
Language), a universal language that was developed

to produce the layout of web pages. Do not become
confused by thinking that HTML is a programming
language — it isn't. It contains codes called ‘tags’ that

a web browser uses to present the text and images on
the web page. The browser then interprets these tags to
produce and format the web page for you to view.

The use of HTML helps in two major ways:

¢ 1o share documents: HT ML was created to help
users share documents on the Internet, so that any
browser can read a basic HTML document.

o 1% link to other documents: Hyperlinks use an
Internet address for the related documents in
the HTML code for the page. Clicking on the
hyperlink either downloads the related material or
views the document.

Any web browser can be used to access a web page.
The most common browsers are Google Chrome,
Microsoft Edge, Microsoft Internet Explorer, Mozilla
Firefox, Opera and Apple Safari. Browsers let you view
HTML files, but not create them.

You can open a web page by entering a unique web
address called a URL in the address bar. For example,
typing ‘www.oup.com/oxfordcsecforit’ opens the
support web page for this text. You can also use

a search engine to find a web page.

In the early days, web pages were intended to only

provide information for education and the government.

—
—

Now, new websites are being created and existing ones
are being updated and modified every day.

A website can be a standalone web page or multiple web
pages linked together through navigational links. Some
general categories of websites are explained in Table 6.1.

Table 6.1 Categories of websites

Static The content of this websites remains generally
website the same and in this way is like an online
version of a paper-based brochure. Viewers
cannot search for content.
Editable This website is the interactive version of the
brochure brochure website. Content is stored as it is
website updated so that visitors can search for and
view past articles, web pages or other content.
Dynamic Here a user can login and create new content,
website add content, insert images and generally
control what is viewed on the website.
E-commerce This is a website that is integrated to receive
website online payments from visitors to the website.
Aweb Web apps provide push notifications and can
application  be added to a device's home screen without

having to download it from an app store.
Twitter Lite, Pinterest and weather apps are
examples that push notifications to the user's
phone or browser.

Websites are popular because they cater to all types

of audiences for education, entertainment, sports or
informational purposes. Knowing the purpose of a
website therefore sets the tone for its content and
organisation. Creating a website that is formal or
informal reflects the seriousness or carefree impression
that visitors will use to decide if they continue to
browse the pages. Table 6.2 provides examples of some
types of websites and their purpose.



6.1 Introduction to web page design

Table 6.2 Descriptions of websites and their use

Use of website
Entertainment

Corporate

Shopping

Information

Community-building
or social networking

Academic or
professional

Personal or blogs

Mobile

Directories

Explanation

These websites use videos, graphics and live streaming to market their products, or
for entertainment. Many online games and video sites use Adobe Flash software to
display content, so sometimes people call entertainment sites 'flash’ websites.

Also called a business website, which uses the website for marketing and not to
conduct business. The website provides information to users about the company
and can also provide customer support.

These are e-commerce websites selling products. Users can browse and select
products and pay online with methaods such as a credit card or PayPal.

These websites provide users with a repository of historical and current information,
such as news as it happens around the world. Other websites provide information in
the form of encyclopaedias, training or general education.

These websites focus on the social interaction of people who want to communicate
with others who share a common interest. Users share personal details, pictures and
events with friends, family and acquaintances.

Users share their resumes, portfolios and career accomplishments online for
potential employers and clients.

Personal websites are created and owned by individuals who share their personal
profiles and specific interests. These websites are weblogs or blogs — generally
online diaries, journals or editorials that reflect whatever is going on in the writer’s
life or business. The writer may even comment on politics or news or share personal
opinions.

These websites are ideal for mobile devices and are often offered as an alternative
to the normal version of a website when connecting with a mobile device. Their
content is viewed better on a narrow screen width and uses less data to display the
information.

These websites are a type of online directory. However, instead of searching
alphabetically, users can search terms and phrases in search engines.

Examples
YouTube, Netflix,
sports sites, online
games

cxc.org, oup.com

Amazon, eBay

Wikipedia, MSNBC,
Fox News, CNN
Notesmaster,
Caribbean360
Facebook,
Instagram, Flickr,
SoundCloud, Twitter
LinkedIn, Academia,
ResearchGate
Personal blogs,
forums, video blogs
(vlogs)

Any website created
for viewingon a
mobile device

Yellow Pages,
Google, Bing

Planning your web pages

Your first task is to decide the purpose of your website.
What do you want your website to do? This determines
what content you are going to put on your web pages,

how it will be organised, and how the pages are linked.

Content

It is very important that the message of your website
is presented in a manner that captures the attention
of those who visit it. The initial screens should attract
visitors’ interest so that they want to browse the site.
The main screens and connecting web pages should
supply enough information and maintain a visitor’s

interest enough to encourage repeat visits. The use of
one or more combinations of colour, images, sound,
video and tone of language can capture or lose a
visitor’s attention.

Organisation

Web pages should be well organised, with information
arranged in categories and subcategories. This helps
the user to browse through information in a sequential
and logical manner, so that interesting sub-topics can
be selected for further reading. You should therefore
sketch how the various web pages relate to each other
and how you would want your website visitors to view
the content on each web page.
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Navigation

Navigational links can include pull-down and pop-up
menus or hyperlinks to other pages or documents. Any
visitor to a website should be able to move through
the main categories or pages in a logical manner or
go directly to an area of interest. Hyperlinks are used
to connect web pages to other web pages or locations
within the same web page or external documents.
Other navigational links are ‘breadcrumbs’ which

are seen in a single line below the web page header.
Breadcrumbs show the path a visitor would have
taken to access the current page, with each one being
a sub-category of the one before it. An example of a
breadcrumb or breadcrumb trail is:

Home > Plants > Potted > Flowers

The visitor can go directly to any of the pages in
the breadcrumb by clicking on the hyperlinks in it,
including ‘Home’, which will take them back to the
opening screen or main web page. Another useful
set of links websites can provide are those to other
websites that are related to your website’s content.

Figure 6.1 shows the address or URL of a particular
web page, also called the path.
® www.oup.com/oxed/international/itforcsec/

Fig 6.1 The URL of a web page is shown in the address bar

Economy

You should be aware of the number of web pages a
visitor must view before seeing the page of interest.
Also, not all users have the same Internet connection,
so modem speeds for dial-up customers may increase
the time taken to view a page that has many images
or videos. Websites aimed at, or optimised for,
mobile devices also take this loading-time issue into
consideration.

Security

A website should have ample security features to assure
confidence if users are providing sensitive data, such

as credit card or personal information. These security
teatures should include measures to prevent hackers
and viruses from compromising the integrity of data,
information and hardware.

Questions

1 Name the application thatis used to view a web
page.

2 State the name of the universal language that s
used to produce web pages.

3 State the names of three common browsers.

Suggest two ways in which a user can open or
locate a web page.

5 Explain the association between a website and web
page.

6 State the category of website where users must
login to edit content.

7 State the general purpose or category of website
that is used for:
a online purchases
b viewing on a small device
¢ socially interacting with others.

8 State three features that should be considered when
planning a website.




As you start your design, you need to think about who
will be interested in the web pages and consider the
layout and links to other pages. Remember that every
web page is different, but most have certain features
that are common to all web pages. There are many
online website builders that offer free design features
or templates so that users spend less time with
formatting and more time focusing on the content.

A general layout of a web page is shown in Figure 6.2.

Header
Left Right
sidebar Content sidebar
Footer

Fig 6.2 General layout of a web page

The header displays the name of the website, web
page, blog name, logo or company name. The name is
usually placed at the top left corner of each web page.
The header also provides a short statement or phrase
that explains the purpose of the web page. If you are
on a web page that is not the main page, clicking on
the header takes the user back to the main page.

Designing a web pége @

S

The left or right sidebar includes a navigational bar or
menu that shows links to each of the major sections of
the web page.

The content area contains the most important
paragraphs or images on the web page. The information
that you place here should attract the visitor into reading
more and staying on the web page or website.

The footer should include any other information that
is important and should be included on all web pages.
It should include how recently the content was placed
there, any contact information and copyright, legal or
privacy notices.

Web page content

You should really create a web page based on a topic
that you know something about. If this is the first web
page you have created, do not make it too large and
ambitious. Some ideas for web pages could include
advertising a trade or business such as hairdressing,
landscaping or music production.

A simple structure will be sufficient to develop your
skills at preparing the information for display and
building the site. Sketch a plan of the website’s structure
to get an idea of what you want to share (Fig 6.3). You
can also visit each of the recommended website builders
in the syllabus. Each one provides samples of online
stores, blogs, business and personal websites.

HOMEPAGE
|
[ | T ]
Planting Payment and
Flowers Plants s delvery
Schedule a
Potted Garden visit
Fig 6.3 Plan the structure for Seeds Seedlings

yourweb pages




6 Web page design

Backgrounds and themes

When you create a web page, you should consider
using a background or theme to help capture the
attention of a visitor. This includes the use of colour,
images or watermarks to create an interesting
background for your web pages. A theme can be
used to give your web pages a professional look, for
example having all navigational links looking similar,
and the background colour, the font and font colour
consistent throughout.

Text and images

Many website builders have options for you to insert,
upload, edit or remove your text, images and videos.
Images and videos can be embedded among the text,
or the text can flow around the image (Fig 6.4). If you
create simple web pages using Microsoft Word, any
text, graphics, tables, hyperlinks and other information
in the document will be converted to a web-
compatible format when you save the document as a
web page. Although early versions of Microsoft Word
could not create web pages, saving your document as a
single web page converts any text and formatting into
HTML code. Any images are also converted into web-
compatible graphic formats.

Hyperlinks and bookmarks

Hyperlinks and bookmarks can add structure,
organisation and navigational functionality to your web
page. Visitors to a website use hyperlinks to move from
web page to web page. A hyperlink can be an icon,
image or word that automatically opens another file or
document for viewing. You click on a hyperlink to:

+ be directed to another web page, file or document
+ be directed to another position within the web page
(also known as using a bookmark)

¢ open a new email message to send using contact
details given on the website.

What's for sale!

It's not often you come across a
shade tree that not only provides
ample shade, but it looks stunning
while it does. Drought-tolerant and
with no diseases or pests, there's
no maintenance to worry about!
Able to grow in climates with hot,
dry summers, and even tolerant of

pollution and urban conditions, you

can grow this tree anywhere.

Flame red is the best seller for

fall color. The fiery autumn foliage
of the Burning Bush makes it an
excellent landscape plant... and

it really draws attention when

planted in rows. In summer, the

cooling blue-green colored leaves

are welcoming and |ush.

Fig 6.4 Images are useful tosupport the content on the web page. The
hyperlinks on this page are shown in bold.

You should therefore have a table of contents
navigational area or home area to allow visitors to use
hyperlinks to select specific areas of interest. Hyperlinks
can be created in Word, and function the same as

they would on an actual web page. You can create the
hyperlink so that when the user clicks that particular
portion of text or even an image, the user is directed to
your specified place in the current document, to a web
page or to a given email contact address (Fig 6.5).

You can also fill out a ScreenTip describing the link to
those who may want a description.

http://www.flameredfoliage.fl
Ctrl+ Click to follow link

Flame redis the best seller for

fall color

Fig 6.5 The underlined text in blue indicates a hyperfink
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Insert Hyperlink ? b4
Link to: Text to display: Creating a hyperlink ScreenTip...
= ‘- N B @
Existing File o Look in: 832938 Word Files ] &Qq s
Web Page '] 832938 CHO8_word ~ Bookmark...
Q) Current Folder |@° 832938 CHO09_word
Place in This | | Target Frame...
Document |
- Browsed Pages |
) .
Create New
Document
Recent Files
5 v]
E-mail Address Address: | T
oK Cancel
Fig 6.6 A hyperlink can be created to link to different documents and locations
Bookmarks are hyperlinks that jump to a different Bookmark ¥ X

part of the web page. They are especially useful on very Booknisrk nane:

large documents with many words or sections. They o S—

- =
are typically a name, word or phrase that you assign to e S Relete

a location on the page that you may want to reference
later. This means that rather than looking through the

whole document or page searching for the location, the
bookmark feature can easily locate it.

Note that when naming a bookmark, it should: sotby: () Name
®|Location)
+ begin with a letter and can include numbers Clidaine
+ not have any spaces between the words. However, o
S8

you can use the underscore to join words for longer

names. Fig 6.7 Bookmarks are hyperlinks that jump to a different part of the web page
—

Questions

1 In the general layout of a web page, explain what is

ou would rearrange the web pages for a different
displayed in the header. y 9 Pag

perspective,
2 Use Figure 6.3 for the following questions:

a Write the breadcrumbs that show you have
navigated to Seedlings.

b Figure 6.3 is not the only way that the website can
be organised. Create another sketch on how

3 Explain how a bookmark is similar to a hyperlink.

4 Describe three ways in which a user can be directed
by clicking on a hyperlink.
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P

Practical exercises using Microsoft Word [N

Exercise 1: Adding a bookmark

1 Open a blank Word document.

2 Type =rand(6,4) and press Enter. This creates
random text in your document. Save the
document as ‘Chapter6 Ex’.

3 Select the first word on the page.

4 Select Insert on the Menu bar or ribbon, then
choose Bookmark ...

5 Type the name “Top’ and click Add.

6 Locate the sixth paragraph and select the last
word in the paragraph.

7 Select Insert on the Menu bar or ribbon, then
choose Bookmark.

8 Type the name ‘End’and click Add.

To go to a bookmark:

1 Select Insert on the Menu bar or ribbon, then
choose Bookmark.

2 Select the bookmark name and click Go to.

3 Try locating the Top and End bookmarks.

To delete a bookmark:

1 Select Insert on the Menu bar or ribbon, then
choose Bookmark.

2 Select the bookmark name and click Delete.

3 Delete the bookmark named End.

Exercise 2: Using hyperlinks to be directed to an
existing document

1 Open a blank Word document.

2 Type the following sentence: “This sentence
contains a hyperlink HERE.’

3 Select the word ‘HERE’.

4 Click Insert on the Menu bar and select
Hyperlink. In recent versions of Microsoft
Word, you select Link = from the Insert tab.

Another option is to right-click on the text and
click Hyperlink (or Link).

5 On the left pane, select Existing File or
Web Page.

6 Browse to locate and select the ‘Chapter6 EX’
document.

7 Click OK.

8 Move the pointer over the word ‘HERE'. Press
Ctrl + Click to open the ‘Chapter6 Ex’document.

This sentence contains a hyperlink HERE

eeeeeeeee

Dpcimm

Fig 6.8 Linking to an existing document

Exercise 3: Using hyperlinks to be directed to a website

This exercise will show you how to create a
hyperlink to access a website in your browser. To
see this happen, you should have access to the
Internet and be online.

Most versions of Word recognise the format of web
addresses and other file paths, so when you type

one in and press Spacebar or Enter it automatically
creates a hyperlink in that text. For example, type
‘www.oup.com/caribbean’in a Word document. As
you press Enter or the Spacebar, the website becomes

a link that looks like www.oup.com/caribbean

To create a hyperlink using specific text:

1 Open a blank Word document and type the
following sentence: “This Sentence contains a
link to a website.’

2 Select the word ‘website’.

3 Select Insert on the Menu bar or ribbon, then
click Hyperlink (or Link). Alternatively, right-
click on the text and click Hyperlink (or Link).
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In the Address area in the lower part of the
dialogue box, type ‘www.oup.com’.

6 Click OK.

7 Hover the pointer over the word ‘website’. Press
Ctrl + Click to open the link in your browser.

| irsen Hyperink 1 *
Link te: Test to display. website Sereenlig
.8 Look
g Pl

| 8" ChaptertEs Bpokmar

Taiget Frame...

;A oup.com| - I

|_6|__J Cancel

Fig 6.9 Linking to a website
To create a hyperlink using an image:

1 Open a blank Word document and add an image
by copying and pasting one into the document
or using the Insert tab and selecting one of the
options in Illustrations.

2 Select the image.

3 Select Insert on the Menu bar or ribbon and
click Hyperlink (or Link). Alternatively, right-
click on the image and click Hyperlink (or Link).

4 On the left pane, select Existing File or Web Page.

5 In the address area in the lower pane, type ‘www.
oup.com’.

6 Click OK.

7 Hover the pointer over the image. Press Ctr/ +
Click to open the link in a browser.

Exercise 4: Using hyperlinks to be directed to a bookmark

This exercise uses the Chapter6Ex document
to move the cursor to a place within the same
document. It is similar to using a bookmark.

1 Open the Chapter6Ex document or use a
document with at least six paragraphs of text.

2 Locate the fifth paragraph and select the first
word in the paragraph.

On the left pane, select Existing File or Web Page.

3 Select Insert on the Menu bar or ribbon, then click
Hyperlink (or Link). Alternatively, you can right-
click on the text and click Hyperlink (or Link).

On the left pane, select ‘Place in This Document’.
Select the bookmark named Top.

Press OK.

The selected text in the paragraph now looks like

N o G e

a hyperlink.

8 Use the C#r/ + Click option on the hyperlinked
word. You will notice that the cursor has moved
to the location at the top of the document.

Exercise 5: Using hyperlinks to be directed to a new
document

This exercise uses the Chapter6Ex document.

1 Locate the second paragraph and then select the
first word in the paragraph.

2 Select Insert on the Menu bar or ribbon, then

click Hyperlink (or Link). Alternatively, right-

click on the text and click Hyperlink (or Link).

On the left pane, select Create New Document.

w

4 For the new file, type the name ‘Exercise 5 —
hyperlink to new document’.

5 You can use the current location shown under Full
path or click Change and browse to another location
such as the desktop or your secondary storage device.

6 Select the option to Edit the new document later.

Click OK.

8 Hover the pointer over the text you created the
link in and press C#r/ + Click to be directed to
the new document named Exercise 5 — hyperlink

~

to a new document.

.........

Fig 6.10 Creating a hyperlink to a new document »
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Exercise 6: Using hyperlinks to create a blank 4 Copy the word ‘More’, move the cursor to the
email message right end of the lines and press Enfer to move to
A quick way to create a hyperlink to a blank email a new line. Paste the text on the new line. Then
message is by typing the email address in a word create a hyperlink on your pasted text to open the
document and pressing Enter or the Spacebar. However, ‘Chapter6 Ex’ document. You can look at the steps
if the email address link is to be included in some text in Exercise 2 to help you do this.

you may want to use this second option. 5 Edit the new hyperlink from step 4 and change

the Text to display at the top of the dialogue box
to ‘Even More'.

Edit the Even More hyperlink on the second
line so that it opens a new document named
Chapter6NewEx. You can look at the steps in
Exercise 5 to help you with this.

1 Ina blank Word document, type ‘Email
Customer Support’, then select the text. 6
2 Select Insert on the Menu bar or ribbon, then
click Hyperlink (or Link). Alternatively, right-
click on the text and click Hyperlink (or Link).
3 On the left pane, select ‘Email address’. "
4 Type your email address or alternatively use
itforcsec@gmail.com (notice ‘mailto:’ appears in

Remove the hyperlink named Even More. Use
the right-click menu item shown in Figure 6.11.

front of it automatically).
5 Type ‘Exercise 6’ as the subject of the message.

6 Click OK. ::' ’;’:;‘::;l'
7 Hover the pointer over the text and press Ctr/ H e e P
+ Click to open a new email message with the th 7D Paste Options: o
recipient and subject you have specified. Pt Tj Gl e
Exercise 7: Editing, copying and removing a hyperlink Fe & Edit Hyperlink... ma.tch
To manage your hyperlinks, first right-click on the ¢ e Open Hyperlink A dlfﬂ?r
text or image, and then click the option to Edit, o o o k Desig
Copy or Remove the hyperlink. The pop-up menu is 8r s pourney
shown in Figure 6.11. @ sadi
1 Inablank Word document, type More with less’. bt Lont.. eyoun
2 Select the word ‘More’ and create a bookmark fi Paragraph... ions ap
named First. You can look at the steps in _ then c
Exercise 1 to remind you how to do this. Snsfsioskug
3 Select the word ‘less’ and create a hyperlink that Synonyms » prewd
will jump to the bookmark named First. You Translate -ec.i . :’
avice.

can look at the steps in Exercise 4 to remind
you how to do this. Look for ‘First’in the tree of
bookmarks that appears when you have selected

New Comment
Wiicn yuu wien v viucO, YOu
i ) Click Insert and then choose the el
Place in This Document on the left pane.

Fig 6.10 Removing a hyperlink




There are many online web builders available to assist

users with creating their websites and web pages.
While a word processor can create a basic set of web
pages and connect them via hyperlinks, the syllabus
also recommends a few web builders such as
webnode.com, weebly.com and wix.com

Getting started

Most web builders require registration of the uset’s
email address and password along with an initial name
for the website before you can start to create any web
pages. Once you have registered, you need to select the
type of website that you wish to create. For example, will
your website be one for personal use or business?

Once you have made your selection, the web builder
could filter some website templates for you to preview
and select one that will be used to create your content.

Adding content

Now that you have chosen your overall template,
you can use the options available to browse and add

Fig 6.12 Templates help you decide on a suitable design for your web page

other web page designs that are suitable for your
website concept (Fig 6.12). Some designs may contain
columns, graphics or contact information, while other
may contain sections for graphics or videos. The sample
designs contain random text and pictures for you to
preview your web page. However, the web builder

also includes options to change font types, font sizes
and text alignment; add your own graphics, pictures

ot video; and edit the background colour or upload

a background image. Added features, such as the
integration of Google Maps to navigate to the location
of your business, a contact form or subscription page
are available for visitors to receive updated information.

If you are not sure of the order or layout of your web
pages, most web builders allow you to rearrange them
using drag-and-drop options. Lastly, there are options
to add a logo, special slogan or social media icons to
personalise your web pages.

Finalising your web pages
Before publishing your web pages on the Internet, you
should preview the checklist to test your website:

We are Creative
Agency.
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Make sure that all the headings, links, images, font
colours and so on complement the purpose of your
website and are not too dark or too small when
previewed.

Click on each hyperlink to make sure that it directs
you to the correct web page.

Check that any animations, videos or sounds play as
they should.

Check that email addresses are valid and working.
Check for orphan pages. These are pages that
contain no links back to the previous web page or
to the homepage. Sometimes the only way to go to
the previous page is to use the Back button, but this
does not always work.

Check that the page titles on each web page are
sensible and not too wordy. Page titles are important,
since they appear in search engine results and in
browser bookmarks.

Since you do not know how your visitors will access
your website, you should also preview it using a
mobile device to see how it looks. Can you view the

content easily? Is the design suitable for this small
viewing window?

Once you are satisfied that all links and web pages are

functioning, you are ready to publish your website.

Most web builders use a single click to publish your
website. However, you can continue to update content

and features as necessary.

2 List some of the features that are available for

3 Explain why you should test your website before

4 Describe three checks to test a website.
5 Whatis the name of the web page that contains

Questions

1 What do most web-building applications require
before you can create a website?
creating a website.
publishing it.

no links back to the previous web page or to the
homepage?

Practical exercises using a notes program

Exercise 8: Creating a static web page

1 Locate and open Notepad, or alternatively
WordPad. Note that writing HTML code is
not required in the syllabus but this exercise
demonstrates how it works.

2 Type the following as accurately as possible.
<html>
<head>
<title> A title goes here </title>
</head>
<body bgcolor=“white” text="blue”>
<h1> A web page </h1>
This is a line of text that will be viewed as a web
page.
</body>
</html>

3

\

Save the file as MyPage.html. You can save it on
the desktop but make sure to note EXACTLY
where you saved the file. Then minimise this
window.

Browse to locate the MyPage.html file. Then
double-click the file.

You should see your text in the browser.

Now, maximise the MyPage.html window, and
change the blue in ‘text=“blue”’ to green. Save the
file again.

Now maximise the browser and refresh the page.
The colour of the text should change in your
browser.

Try changing the colour to orange, red and violet,
saving the html file each time, and refreshing the

o

-

browser after each change.
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Insert Design Layout References Mailings Review View Developd
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My first page

What ever I type will be shown on this web page, once I type it in this body section.

Fig 6.12 Creating a static web page

Pra.r:tlcal EXE rC.'ISES Usttig an 1 Select one of the options. Decide on a concept
online web builder for your website and create a sketch of a

Exercise 9: Use a free web builder to create web pages homepage and at least two levels of detail in
the structure.

2 Select one of the recommended free website
builders and, if you have not done so already,
then complete the free online registration.

1 Select one of the recommended free website
builders in the syllabus and complete the free
online registration.

2 Look at the basic website structure in Figure 6.3.

Create a web page using one of the rectangles 3 Give the website a suitable name.

in the structure to develop an idea for your web 4 Select a design appropriate to the business idea.

page. 5 Add at least two graphics, pictures or videos.
3 Include pictures and text to enhance the look of 6 Create a hyperlink to link relevant text to

your web page. Echtent
4 Ensure that the fonts and colours are suitable for a in the same web page

the topic. b in another web page

¢ to an email address.

Exercise 10: Using a web builder to create a website 7 Preview the website and use the checklist to
You wish to create a website based on one of the evaluate for user friendliness and that the content
following business ideas: displays effectively.

« whatrsdon 8 Obtain permission from your instructor before
: : publishing the website.
+ online gaming

¢+ gardening.




° End of chapter exam-style questions

Multiple choice questions

1 Anexample of a browser is: 7 The header of a web page usually contains:
a docs a summary information
b forms b alogo or company name
¢ sheets ¢ major sections of the web page
d Chrome. d copyright, legal or privacy notices.
2 Ane-commerce website: 8 Abookmark can connect to any of the following, except:
a isastandalone web page a HTML code
b receives online payments b an email message
¢ stores resumes and portfolios for its users ¢ another web page, file or document
d stores articles, web pages and other d another position within the web page.
content.
9 Usually, an orphan web page means there are no:
3 Browsers let you HTML files. a email addresses
a edit b ftitles on the web page
b view ¢ links connecting to other web pages
C create d major sections on the web page.
d delete.
10 The following are all examples of free online web
4 The least commonly used browser is: services for creating websites, except:
a Edge a Wix
b Opera b Word
¢ Firefox ¢ Weebly
d Navigator. d Webnote.
5 The path a visitor would have taken to access a web Short answer questions
page is called a: 11 Nathan wants to use a special keyboard to play
a list music at weddings.
b web page a State the name of a special keyboard that can
¢ hyperlink

d breadcrumb.

The current page in the path Home/ Water /Bottled /
Reusable is:

play music.
b Afriend records a video of him playing music on
the keyboard.
i Explain what type of input and output
devices he should use for the recording.

a Home ii State the name of a website where users can
b Water watch these videos.

¢ Bottled ¢ Nathan decides to use a web page to advertise
d Reusable.

his music.
i Describe the category of web page that is
most suitable for him to design.
ii Give one free online website that he could use.



12 He wants to name his website Nathan’s Speciality
Music, with links to samples of his music and videos
of him playing. The main content provides the costs
per hour and booking form, along with copyright
information.

a Sketch a layout of the web page, showing the
sections with the information.

b Nathan designed an online form for clients
to make bookings (Fig 6.13). For each of the
following, state the name of a suitable content

control:
BOOKING FORM:
MUSIC FOR SPECIAL OCCASIONS
First and Last Name: Click or tap here to anter first and list name in UPPERCA
Email address: Foter eeal sddeess. Contact Number:
Location of Party:
Type of party: O Children's (1 Teens [ Adult [ Office
Day: [{| (hoose & day, [Fime of party: (hoose © re Date of Party:seie 2 dae
;Ehooieanitem. Submit
| Sunday
T |Monday
E!’umdav
Thursday

|Friday
|Saturday

Fig6.13

13

14

15

16

6 End of chapter exam-style questions

i Email address
ii Type of party
iii Day
iv Date of party
v Submit.

Write an example of a booking in the form for a
children’s party on Wednesday.

Explain what Nathan needs to do to transfer videos
of his music to the web page.

Nathan clicks on a video on the web page to view
it, but there is no sound. Explain a possible cause of
this problem.

A few weeks later, Nathan sees his videos on another
website advertised by someone else. Describe what
type of computer system misuse has affected
Nathan and his videos.




